# Table of Contents

## 1.0 Introduction and Installation
- 1.1 Product Description and Overview .......................... Page 3
- 1.2 Understanding System Requirements ......................... Page 3
- 1.3 Getting Help ............................................ Page 3

## 2.0 Creating a Quantum Facility ................................ Page 5
- 2.1 Installing the Primary Processor Card ....................... Page 5
- 2.2 Establishing Network Settings .............................. Page 6
- 2.3 Programming the Processor Cards ......................... Page 6
- 2.3.1 Programming Options ................................ Page 6
- 2.3.2 Programming the Processor Cards .................. Pages 7-9
- 2.3.3 Communicating Within a Quantum Facility .......... Page 9
- 2.4 Upgrading from Multicom to Quantum .................... Page 9

## 3.0 Accessing Quantum Commander ................................. Page 11
- 3.1 Understanding User Types ................................ Page 11
- 3.2 Accessing the Login Screen ................................ Page 11

## 4.0 Specifying Facility Information ................................. Page 13
- 4.1 Defining System Parameters ................................. Page 13
- 4.1.1 Adding System Parameters .............................. Pages 13-15
- 4.1.2 Modifying System Parameters .......................... Page 15
- 4.2 Configuring Zone Information .............................. Page 15
- 4.2.1 Specifying Zone Information .......................... Pages 15-16
- 4.2.2 Modifying Zone Information ........................... Page 16
- 4.2.3 Deleting Zone Information .............................. Page 17
- 4.3 Defining Schedule Information .............................. Pages 17-18
- 4.3.1 Creating Daily Schedules ............................... Page 18
- 4.3.2 Assigning Daily Schedules ............................. Page 19
- 4.3.3 Defining Holiday Schedules ............................ Page 19
- 4.3.4 Copying Schedule Details ............................... Page 20
- 4.3.5 Overriding Daily Schedules ............................ Page 20
- 4.3.6 Modifying Schedule Details ............................ Pages 20-21
- 4.3.7 Deleting Schedule Details ............................... Page 21
- 4.4 Defining Administrative Group Assignments ............... Pages 21-22
- 4.5 Defining Class of Service ................................ Pages 22-24
- 4.5.1 Creating and Modifying CoS Settings .................. Pages 24-25
- 4.6 Understanding Neighbor Lists ............................... Page 25
- 4.6.1 Creating Neighbor Lists ............................... Page 26
- 4.6.2 Modifying or Deleting Neighbor Lists ................. Page 26
5.0 Configuring the QSPC1 ........................................ Page 27

5.1 Understanding QSPC1 Card Information .............. Pages 27-28
  5.1.1 Configuring Additional QSPC1 Cards ........... Page 29
  5.1.2 Deleting QSPC1 Information ......................... Page 29

5.2 Defining Station Settings ................................ Page 29
  5.2.1 Configuring Station Settings ...................... Pages 30-32
  5.2.2 Excluding Paging Capabilities .................. Page 33
  5.2.3 Copying Station Settings ......................... Page 33
  5.2.4 Deleting Station Settings ......................... Page 33

6.0 Using System Tools ................................. Page 35

6.1 Downloading Information to the Quantum Commander .. Page 35
  6.1.1 Downloading Software .......................... Page 36
  6.1.2 Downloading Announcement Files .......... Page 36
  6.1.3 Downloading Tones ........................... Page 37
  6.2 Running Diagnostic Tests .......................... Page 38
  6.3 Performing a System Backup ..................... Page 39
  6.4 Restoring the System ............................... Page 39

7.0 Accessing Administrative Functions ................. Page 41

7.1 Selecting Tones and Announcements .................. Page 42
7.2 Distributing Audio .................................... Page 43
7.3 Configuring Input Relay Closures .................... Pages 43-44
7.4 Configuring External Relays .......................... Pages 44-45
7.5 Configuring Media Assignments ...................... Pages 45-46
7.6 Arming/Disarming Security Zones .................... Page 46
7.7 Outside Line Status ................................... Page 47

8.0 Configuring Account Information ................. Page 49

8.1 Adding Login IDs ..................................... Page 49
8.2 Deleting Login IDs .................................. Page 50
8.3 Changing User Passwords ............................ Page 50

9.0 Creating a System Report ......................... Page 51
Chapter One

1.0 Introduction and Installation

1.1 Product Description and Overview

The Quantum Commander is a comprehensive communications network solution. With its flexible, easy-to-use IP-based software, the Quantum application interface enables quick and efficient networking and programming of Multicom second-generation administrative communication systems. Quantum simplifies routine network communications, enabling intra- and inter-facility connections by linking administrative and staff locations within a single building, between multiple building sites, throughout a school campus or across an entire school district.

With the Quantum Commander, you can:

• Control facility bell schedules, announcements, and alarm tones from the easy-to-use browser-based interface.
• Interconnect and communicate between multiple Quantum systems within a building, campus or district.
• Download software updates and administrative announcements to the Quantum system and distribute the information to the rest of the facility or facilities. Announcements are recorded as .wav files and downloaded to the Quantum Commander.
• Test Quantum components, including analog, station and telephone cards.

1.2 Understanding System Requirements

To configure and operate the Quantum Commander, the network must meet the system requirements outlined below.

Software Requirements
The minimum operating system and software requirements that your PC system needs to run, configure and maintain the Quantum network include:

• Internet Explorer® 6 or higher
• Java™ Runtime Environment (JRE) version 1.5.0_06 or higher
• High-speed Ethernet 10/100 connection

NOTE: All nodes must be on the same network and firewalls can not exist between nodes. To access Quantum remotely (from a different network), see your Network Administrator for access instructions.

1.3 Getting Help

If you need help while installing or operating the Bogen Quantum Multicom IP, call Technical Support at 1-800-999-2809, option 2, Monday through Friday, 8:30 am through 5:30 pm Eastern Time Zone. Or, send e-mail to support@bogen.com.
Chapter Two

2.0 Creating a Quantum Facility

Quantum enables intra- and inter-facility communication between two or more Quantum System Process Cards (QSPC1). With IP-based communication software, Quantum provides simple and secure virtual networking, simplifying both routine and non-routine scheduling and administrative functions.

Each facility can consist of one primary, one secondary and up to 62 normal systems or nodes. The primary identifies the QSPC1 that acts as the access point for all programming changes. The secondary acts as backup to the primary, assuming the role of the programming interface if the original primary is out of service, with the remaining QSPC1 cards designated as normal systems.

Quantum also identifies each system with a node number. The primary system is one (1), the secondary is two (2), and each normal QSPC1 will follow in order of creation. A node identifies one QSPC1 processor board. The board can be installed in a max. 240-station rack, max. 120-station rack or wall mount, or max. 48-station compact rack system.

2.1 Installing the Primary Processor Card

The primary processor card contains the microprocessor, Network Interface with 12 DSP channels (8 voice channels and one (1) wideband channel, and three (3) channels for various tone generation), memory and system clock. The system requires at least one processor card regardless of system capacity. The primary processor card is installed in the first position of the card frame.

NOTE: See Section 2.3.2 for explanation of Processor Card indicators.
2.2 Establishing Network Settings

Prior to using the Quantum Commander, change the network settings as specified below.

1. From the Start Menu, select the Control Panel option.
2. Select Network Connections.
3. Double click on the Local Area Connection option.
4. Select Properties.
5. On the General tab, scroll down to select the Internet Protocol (TCP/IP) connection option.
7. From the General tab, select the Use The Following IP Address option.
8. On the IP address line, type: 010.010.001.XXX where XXX is a number between two (002) and 255. The number 001 is reserved for the card itself.
9. On the Subnet mask line, type 255.000.000.000.
10. Leave the Default Gateway field blank.
11. Select OK

Your computer is now ready to connect the crossover cable to the debug port on the QSPC1.

NOTE: After completing the programming of the processor cards outlined below, switch the network connection settings back to the original values

2.3 Programming the Processor Cards

Each of the Quantum QSPC1 cards must be programmed with basic IP information using a crossover Ethernet connection from the debug port on the QSPC1 to the programming computer. This process applies to the initial setup of all QSPC1 cards.

2.3.1 Programming Options

Prior to configuring any general system information, designate and program the primary processor card. All information is disseminated through the primary card to other cards within a facility. There is only one primary card per facility. You can program the processor cards either on- or off-site.

- **On-site using the Maintenance ID** – You can program the primary, secondary and normal processor cards entirely on-site using the default maintenance ID, and following the steps outlined in section 2.3.2, Programming the Processor Cards. When electing to program the cards on-site, with the power off, load the primary card into the processor card slot. Power up the system and ensure that the red power LED light is on. After the system boots up, the amber diagnostic LED will also be on. This indicates that the card is not yet configured. When you complete the programming for all processor cards, including secondary and normal cards, access Quantum using the default Admin ID and password.

- **On-site using the Maintenance and Administrative IDs** – You can program the primary card on-site using the maintenance ID and following the steps outlined in section 2.3.2, Programming the Processor Cards. The secondary and normal processor cards are then programmed using the administrative ID to access the Quantum configuration screens (for more details on configuring the secondary and normal processor cards, see section 5.0, Configuring the QSPC1).

- **Off-site** – The dealer installs a QSPC1 in a shop system, and then programs the cards entirely off-site.
2.3.2 Programming the Processor Cards

To program and establish the processor cards, follow the process below.

1. Turn the system power OFF and install primary card in slot 1. Then turn power back ON.

2. Connect the Ethernet crossover cable from the DEBUG PORT (lower jack) on the card to the computer Ethernet connection port. Wait for card to finish booting-up.

Processor Card Indicators

<table>
<thead>
<tr>
<th>STATE</th>
<th>STATUS (Green)</th>
<th>DIAGNOSTICS (Amber)</th>
</tr>
</thead>
<tbody>
<tr>
<td>BOOT-UP*</td>
<td>Both STATUS and DIAGNOSTICS cycle ON/OFF and boot-up progresses</td>
<td></td>
</tr>
<tr>
<td>OPERATIONAL</td>
<td>ON</td>
<td>OFF</td>
</tr>
<tr>
<td>UNCONFIGURED (No IP Data Programmed)</td>
<td>OFF</td>
<td>ON</td>
</tr>
<tr>
<td>BOOT-UP FAILURE</td>
<td>OFF or BLINKING</td>
<td>OFF or BLINKING</td>
</tr>
</tbody>
</table>

* Boot-Up may take several minutes

Table 2-1: Processor Card Indicators

STATUS: indicates operational state of processor, ON steady after boot-up.

DIAGNOSTICS: indicates start-up diagnostics in processor, OFF steady after boot-up.

3. Access Internet Explorer version 6.0 or higher. Type the address below and select the GO arrow
http://10.10.1.1:8080 to access the Quantum Commander Login Screen. The specific IP address for the debug port is defined at the factory.

4. Move to the User Name field and login using the maintenance User Name and password:

User Name: ______________________ Password: _____________________

The ID and password must be in lowercase and can not be modified. (Refer to section 3.2, Accessing the Login Screen for more detailed login procedures.) Select Submit to access the Node configuration screen (see Fig. 2-2, QSPC1 Network Configuration Screen).

Node Configuration

5. Select a Facility Number from the drop-down menu. The system defaults to a value of 1. Facilities that will be communicating with one another must have unique facility numbers. A facility can have up to 64 nodes or QSPC1 cards.

6. Select a QSPC1 # between 1 and 64 from the drop-down menu. The system defaults to a value of 1 representing the primary QSPC1. A value of 2 is used for the secondary unit. Specify a value of 3 through 64 for normal units.

NOTE: Be certain that there is ONLY 1 primary card per facility.

7. Enter the System IP, Subnet Mask, Default Gateway and Multicast IP addresses. The system defaults these fields to blank. These values are required to operate the system and are all user-specified. For field definitions, see Figure 2-2. For valid values, see the network administrator.
8. Select the card type from the drop-down menu. Valid types include Primary, Secondary and Normal cards. The system defaults to Primary.

9. Select the configuration type from the Unit drop-down menu. Valid unit types include Rack Mount, Wall Mount and Compact Rack Unit. The system defaults to Rack Mount.

10. Select Submit. The system will automatically reset.

11. When the card’s green status light turns on and the amber diagnostic light turns off, disconnect the Ethernet crossover cable from the primary QSPC1.

12. Follow steps 1 through 11 for the unit’s secondary (QSPC1 2) and normal processor cards.

**NOTE:** The system IP address must be a static IP address.

**NOTE:** When adding new or modifying parameters for existing system cards, you must use the maintenance ID and password to program the new card information.

---

**Fig. 2-2: QSPC1 Network Configuration Screen**

- **Facility #** Identifies the Quantum facility. The facility number must be unique from other facility numbers within a neighbor list. The system defaults to 1.
- **QSPC1 #** User-defined numerical (1-64) field used to identify the specific QSPC1. The system defaults to a value of 1 which identifies the card as the primary. Each QSPC1 within a facility must have a unique number.
- **System IP** Identifies the static IP address associated with the node. Also called the Primary Server IP.
- **Subnet Mask** Identifies how many bits in an octet(s) identify the subnetwork, and how many bits provide room for host addresses. The subnet mask is represented in dotted decimal notation, four numbers from zero (0) to 255 separated by periods, e.g. 255.128.0.0.
- **Default Gateway** Specifies the router on the network that serves as an access point to another network. The default gateway is used when an IP packet’s destination address belongs to someplace outside the local subnet. Currently, values are all zeroes, representing No Gateway.
- **Multicast IP** Identifies a group of hosts that have joined a multicast group to enable all-call paging within a facility. The multicast IP must be the same for all nodes within the facility. Valid Multicast IP values include 239.000.000.000 where XXX is 001 through 255.
- **InterFacility Multicast IP** Different from the Multicast IP address defined above, the InterFacility Multicast IP address is used for inter-facility all-call paging (see section 4.6, Understanding Neighbor Lists). Unique facilities use a common Multicast IP address to enable inter-facility communications.
- **Network Time Synchronization** Updates and/or synchronizes the QSPC1 facility time with a Network Time Server.
Creating a Quantum Facility

VoIP
All QSPC1 cards within a facility are connected via a single Local Area Network (LAN), and voice calls within a QSPC1 are completed in standard analog fashion. To address and complete calls between QSPC1 cards, the Quantum processor card is equipped with a digital signal processor (DSP) specifically designed for VoIP. When an approved VoIP telephone connected directly to the network is used to initiate a call or page across multiple nodes, Quantum triggers a Voice over IP (VoIP) call across the LAN. The VoIP phone must have a static IP address on the network similar to a node programmed through station configuration (see section 5.2.1, Configuring Station Settings).

Quantum uses Real-time Transport Protocol (RTP) for audio and TCP/IP for inter-QSPC1 communication. VoIP works within a facility or between facilities when neighbor lists are configured. (See section 4.6, Understanding Neighbor Lists for more detailed information.)

Virtual Private Networks
When users require access to Quantum from outside the LAN, the network administrator can establish this access using a Virtual Private Network (VPN). For successful remote access via a VPN, all nodes must be on the network. See your network administrator for details.

2.3.3 Communicating Within a Quantum Facility

VoIP
All QSPC1 cards within a facility are connected via a single Local Area Network (LAN), and voice calls within a QSPC1 are completed in standard analog fashion. To address and complete calls between QSPC1 cards, the Quantum processor card is equipped with a digital signal processor (DSP) specifically designed for VoIP. When an approved VoIP telephone connected directly to the network is used to initiate a call or page across multiple nodes, Quantum triggers a Voice over IP (VoIP) call across the LAN. The VoIP phone must have a static IP address on the network similar to a node programmed through station configuration (see section 5.2.1, Configuring Station Settings).

Quantum uses Real-time Transport Protocol (RTP) for audio and TCP/IP for inter-QSPC1 communication. VoIP works within a facility or between facilities when neighbor lists are configured. (See section 4.6, Understanding Neighbor Lists for more detailed information.)

Virtual Private Networks
When users require access to Quantum from outside the LAN, the network administrator can establish this access using a Virtual Private Network (VPN). For successful remote access via a VPN, all nodes must be on the network. See your network administrator for details.

2.4 Upgrading from Multicom to Quantum

Existing Multicom customers can upgrade to a Quantum system quickly and easily by replacing the processor card from their existing hardware with the new Quantum processor card. Backwards compatible with all Multicom 2000 systems, the Quantum processor card seamlessly integrates with the existing hardware to provide users with new and enhanced networking features. When upgrading from a system using Bogen Commander to Quantum, follow the steps below.

1. The Bogen Commander enables you to download previously programmed information from the Multicom unit. The data is downloaded to a specific facility database within the Bogen Commander. To download the facility database information, select the Download from Multicom option from the Tools menu.

NOTE: The PCI must be connected to the Multicom unit prior to downloading facility database information. For details on connecting to Multicom, refer to section 3.1, Connecting to Multicom 2000 of the Bogen Commander Software Instruction Manual.

2. Using the Bogen Commander Create FacilityReport option, print a hard copy report of each customer facility database. To create a facility report, refer to section 4.0, Creating a Facility Report, of the Bogen Commander Software Instruction Manual. The report will act as a guide when configuring the new system.

3. To complete upgrade, follow steps 1 through 11 in section 2.3.2, Programming the Processor Cards.
Chapter Three

3.0 Accessing Quantum Commander

Bogen's Quantum Commander provides for a variety of user-types to access, configure and maintain the network, allowing for up to ten unique user ID/ password combinations.

3.1 Understanding User Types

Quantum provides up to three types of user IDs, ensuring controlled system configuration and access. The three user types include technician, administrator, and general user IDs.

Although all users can review configuration and scheduling information, the ability to add, delete or modify information varies based on user type. Technician and administrative IDs access configuration functions, including card configuration, and user ID and password setup. General user IDs provide access to all operational and informational features.

3.2 Accessing the Login Screen

To access Quantum Commander and begin the configuration process, follow the steps below.

1. From your Internet browser, enter the Primary Node IP address as specified on the Node Configuration Screen to access the Quantum Commander login screen (see your network administrator and Chapter 2, Creating a Quantum Facility for more detailed information).

   For example:  http:// 192.168.120.160:8080

2. Move to the User Name field and login using a valid User Name and password:

   User Name: _______________________  Password: ________________

3. Using the mouse or Tab key, move the cursor to the PASSWORD box and type the password associated with the user ID specified.

4. Select Submit or press Enter to access the main Quantum Commander screen.

   NOTE: For more detailed information on establishing user IDs and passwords see section 8.0, Configuring Account Information.

   NOTE: For more detailed information on initial access and setup of the Quantum Commander, see section 2.3, Programming the Processor Cards.
4.0 Specifying Facility Information

The Quantum Commander provides a unique interface to specify the administrative and scheduling requirements necessary for all QSPC1 cards within a facility. Communicating with your network via IP, the Quantum Commander enables quick and efficient setup and maintenance of scheduling, announcement and security tasks. From the main screen, users configure the facility information and then apply these values to the specific QSPC1 units as necessary.

4.1 Defining System Parameters

System parameters include information unique to the facility, including passwords, night ring characteristics, and telephone settings.

4.1.1 Accessing System Parameters

To configure system parameters that apply to the entire facility, select the System Parameters option from the left side of the screen. The System Parameters screen identifies password, night ring, and settings information necessary to access and maintain the system. You can use the mouse or Tab key to move between fields and enter the information as defined below (see Fig. 4-1, System Parameters Screen).

- **Facility Name**
  At the top of the lefthand column, refers to the entire facility.

- **Rename Facility**
  You can customize, or rename, the facility in the Quantum Commander software. To rename, triple click on the word "Facility". You may enter up to 10 characters maximum. When finished entering the new system name, click on the Parameters section of the screen. Then, click "File > Save" to end and save the change.
Specifying Facility Information

Night Ring

Admin Station

Identifies the specific administrative station that handles outside line calls received during non-business hours. Outside line calls not answered within 15 seconds during night hours trigger a ringing tone to all or selected stations as defined in the Page Zones field (see below). The night ring station must be an administrative station as defined when configuring the QSPC1 (for more information, refer to section 5.0). A value of 999 in the Admin Station field disables the night ring feature.

All Station

If checked, indicates that all station speakers receive the night ring tone during non-business hours. If unchecked, only the zones specified in the Page Zones field (see below) receive the tone.

Page Zones

Identifies which zones receive the night ring tone when outside line calls are received during non-business hours. To select which zones receive the night ring, highlight the appropriate zone number(s) in the left column and select the right arrow button. This moves the zone number to the right column. Only zones configured as Page or Page+Time zones are listed. Repeat for each zone as needed. To deselect a zone, select the zone in the righthand column and click the left arrow button.

Note: If the All Station option is selected, this field does not apply.

Settings

Day Start

Identifies when the system switches to its “Day” mode of operation and specifies the time period for which the day administrative station is active. Telephones with night-only outside line access are prevented from placing outside line calls during this time. Valid times range from 00:00 to 23:58; but must be less than the Night Start time.

Night Start

Identifies when the system switches to its “Night” mode of operation and specifies the time period for which the night administrative station is active. During this time, telephones with the night-only outside line access can place outside line calls. Valid times range from 00:01 to 23:59; but must be larger than the Day Start time.

Queue Timeout

Specifies the maximum amount of time that a call switch/handset station can remain on an administrative queue. Valid timeout values range from 1 to 999 minutes. If a call switch/handset station remains on an administrative station queue for longer than the timeout, the station is removed from that queue.

Passwords

System Password

Specifies the user-defined four-digit (0-9) field. Valid values range from 1000 to 9999. The system password is used for inter-facility paging.

DISA Password

Identifies the user-defined four-digit (0-9) field used for direct inward station access.

Security DISA Password

User-defined four-digit (0-9) field used to access Multicom through a security DISA line. This feature requires an analog card (MCACB rev 9 or higher).
Chapter 4 • Specifying Facility Information

4.1.2 Modifying System Parameters

To modify existing system parameters, simply follow the steps outlined in Section 4.1.1, Accessing System Parameters. Changes are effective immediately after saving.

4.2 Configuring Zone Information

Quantum enables the configuration of up to 64 multi-purpose zones as either page, time, page and time, or security. The screen also identifies which stations (e.g., Arch #) are assigned to every zone.
4.2.1 Specifying Zone Information

To access and configure zone information, select Zone Configuration from the left side of the Quantum Commander screen. The Zone Configuration screen lists any zones previously configured. To define or edit any zone, double click anywhere on the row associated with the zone # to configure. Enter the information in each of the zone type, time duration and security closure fields (see Fig. 4-2, Zone Configuration Screen). Use Tab key to move between fields. Select Apply to save the zone information. Configured zone appears on the Zone Configuration screen. Repeat for each zone as necessary.

<table>
<thead>
<tr>
<th>Zone #</th>
<th>Zone Type</th>
<th>Time Duration</th>
<th>Closure Type</th>
<th>Arch #</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Page Zone</td>
<td>1-59</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Time Zone</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Page &amp; Time Zone</td>
<td>1-59</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Security Zone</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>16</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>17</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>18</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>19</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>20</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>21</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>22</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>23</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>24</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Fig. 4-2: Zone Configuration Screen

Zone # Identifies the system-provided number to organize up to 64 zones.
Zone Type Identifies each of the up to 64 zone areas as a page zone, time zone, page and time zone, or security zone.
Page Zone: Identifies stations as receiving audio, but not time tones. Paging is initiated on an as-needed basis.
Time Zone: Identifies stations as receiving time tones, but not audio pages. Activated from an admin phone or via the Quantum Commander, tones are initiated on a time schedule.
Page & Time Zone: Identifies stations as receiving both page and time tones.
Security Zone: Identifies stations as security, and alerts Admin phones and wall displays when tripped. Security zones can be armed or disarmed as necessary via an admin phone or the Quantum Commander.
Time Duration Applies only to time or page and time zone types. Identifies the number of seconds the time tone is active for each time zone. Valid time ranges are from 1 to 59 seconds.
Closure Type Applies to security zone types only. Specifies if a station in the zone is a normally open or normally closed contact.
Arch # Specifies the architectural numbers currently assigned to the zone.

4.2.2 Modifying Zone Information

To modify existing zone configuration information, follow the steps outlined in Section 4.2.1, Specifying Zone Information. Changes are effective immediately after saving.
4.2.3 Deleting Zone Information

To remove a previously configured zone, follow the steps below.

1. Double click anywhere on the row of the zone to delete. The Zone # screen identifies the current zone # and associated information.
2. Select the ‘blank’ value from the zone type field. All associated fields will be cleared.
3. Select Apply to save the deleted zone configuration. The deleted zone no longer appears on the Zone Configuration screen.
4. Repeat for each zone as necessary.

4.3 Defining Schedule Information

The Schedule Screen enables you to add, modify or review up to 32 bell schedules to assign as daily or holiday schedules. To specify the schedule information, select Schedule from the left side of the Quantum Commander screen. The Schedule screen displays the activation time, bell tone, and associated zones for each schedule. It also identifies daily and holiday schedule assignments.

**Schedule**

**Schedule No.** Identifies the schedule number 1 through 32.

**Activate, Tones, Zones** Provides the activation time, tone number and zones associated with the schedule number.

**Copy** Enables the user to copy schedule details from one schedule number to another. Copying will override previously configured schedule information. Useful when entering duplicate or similar time and tone information for multiple schedules.

**Override** Enables the user to override the currently active schedule, replacing it with the schedule number currently displayed on the screen (See section 4.3.5, Overriding Daily Schedules). The override remains in effect until the end of the current day and does not affect settings within the database. At the start of a new day, the system resumes its normal daily schedule.
4.3.1 Creating Daily Schedules

To create daily schedules, select Schedule from the left side of the Quantum Commander screen. The Schedule lists previously configured daily and holiday schedules, and enables the assignment of schedules by number to each day of the week. To create a new schedule:

1. Select a schedule number from the drop-down schedule number field. Number is used to assign daily schedules (see Fig. 4-3, Schedule Screen).
2. Right click anywhere on the white schedule box below the schedule number. A new dialog box opens with Add, Modify and Delete options. If no schedules were configured previously, only the Add option is selectable.
3. Select Add to display the Add Event screen (see Fig. 4-4, Add Event Screen).
4. Specify the schedule start time in 24-hour format on the Activate field. Valid times range from 00:00 to 23:59.
5. Assign a tone to the schedule by clicking on the down arrow for the Tone field. Select the tone number. The system defaults to Tone 1.
6. Move the cursor to the Zones area and click on the zone or zones associated with the new schedule.
7. Click on the right arrow to move the zone numbers from the Available Zones to the Selected Zones box. Only zones configured as Time or Page+Time are available. The zones selected identify which of the available zones receive the associated tone when the time event occurs. Any combination or all of the available zones (maximum of 64) can be selected. The minimum number is one.

NOTE: To select more than one zone at a time, press the Ctrl key while selecting the applicable zones.
8. Select Apply to save the schedule entry. Select Close to end the entry without saving.
9. Repeat steps 2 through 7 to add events to the schedule as necessary. The system automatically sorts the events chronologically.
10. Repeat steps 1 through 8 to create up to 32 schedules as necessary.
### 4.3.2 Assigning Daily Schedules

To assign a schedule to each day of the week, move the cursor to the down arrow for the day to which you need to assign a schedule in the Daily Schedule area (See Figure 4-3, Schedule Screen). Click the down arrow and select a schedule number 1 to 32. Repeat for each day of the week as necessary.

**NOTE:** The system permits the assignment of undefined schedules to daily schedules. If you select an undefined schedule, a bell schedule will not occur on that day. A value of zero also indicates that a schedule is not active for that day. To avoid error, select only a previously configured schedule number.

The Active Schedule field indicates which schedule is currently active. This is a system-populated field.

### 4.3.3 Defining Holiday Schedules

Holidays or other non-regular days often require changes in schedule assignments. To assign schedules to holidays or other non-regular days, follow the steps below.

1. Right click anywhere on the white Holiday Schedule box (see Fig. 4-3: Schedule Screen). A new dialog box opens with Add, Modify and Delete options. If no holiday schedules were configured previously, only the Add option is selectable.

2. Select Add to display the Holiday Assignment screen (see Fig. 4-5, Holiday Assignment Screen).

3. Click on the From Date field to display the Select Date screen (see Fig. 4-6, Select Date Screen).

4. Using the drop-down arrows, select the month and year for the associated holiday.

5. Move the cursor and select the specific day of the month associated with the start date of the holiday assignment. Select OK. The Select Date screen closes.

6. Click on the To Date field of the Holiday Assignment screen to display the Select Date screen.

7. Repeat steps 4 and 5 to specify the holiday end date.

8. Move the cursor to the down arrow of the Schedule field. Select the schedule number associated with the holiday.

**NOTE:** To prevent tones from sounding during a holiday date range, select zero or a schedule number not yet configured.

9. Select Apply. The holiday information appears on the Holiday Schedule field of the Schedule screen (see Fig. 4-3, Schedule Screen).

10. Repeat steps 1 through 9 for each holiday schedule.
4.3.4 Copying Schedule Details

The Copy option enables you to create multiple schedules with the same or similar times, tones and zones. To use the Copy feature, follow the steps below.

1. Select the Copy field to the right of the Schedule box. The Copy Schedule dialog box appears on the screen.
2. In the From box, specify the previously configured schedule number (1 - 32) to copy.
3. Use the mouse or Tab key and move to the To box. Type the number of the new schedule (1 – 32).
4. Select Apply to save the copied schedule or Select Cancel to abandon the copy.

Fig. 4-7: Copy Schedule Screen

4.3.5 Overriding Daily Schedules

To change the current active schedule, Quantum provides an override schedule option. To override the active schedule with another previously configured schedule, follow the steps below.

1. On the Schedule screen (See Fig. 4-3, Schedule Screen) select a schedule (1– 32) from the drop-down menu.
2. Select the Override field to the right of the Schedule box. An alert screen informs the user that the override was successful.
3. Select OK on the alert screen. The Active Schedule field reflects the new active schedule number.

NOTE: If the selected schedule is undefined, a bell schedule will not occur on that day. A value of zero also indicates that a schedule is not active for that day.

4.3.6 Modifying Schedule Details

Quantum enables you to modify specific activation times and tones within a schedule. You can only modify one time tone event at a time. To modify multiple entries, follow the steps below until all entries are modified for the associated schedule.

1. Select a schedule number from the drop-down schedule number field to display the associated schedule details (see Fig. 4-3, Schedule Screen).
2. Select the time event to change by placing the cursor on the associated row and right click.
3. Select Modify from the dialog box. The Modify Event dialog box appears on the screen (see Fig. 4-8, Modify Events Screen).
4. Move to the appropriate field and type, select or check the updated information as described in section 4.3.1, Creating Daily Schedules.
5. When all modifications have been made, select Apply to accept the revised schedule details. The updated time event appears on the Schedule Screen (see Figure 4-3, Schedule Screen).
**Modifying Holiday Schedules**

To modify one or more holiday bell schedules using Quantum, follow the steps below. You can only modify one holiday entry at a time. To modify the schedule assignments for multiple holiday dates, follow the steps below until all entries are modified as necessary.

1. Position the cursor on the row for the holiday time event to change and right click.
2. Select Modify to display the Holiday Assignment screen (see Fig. 4-5, Holiday Assignment Screen).
3. Follow steps 3-9 from section 4.3.3, Defining Holiday Schedules as necessary. The revised holiday event appears on the Schedule Screen (see Figure 4-3, Schedule Screen).
4. Move to the appropriate field and type, select or check the updated information as described in section 4.3.1, Creating Daily Schedules.
5. When all modifications have been made, select Apply to accept the revised schedule details. The updated time event appears on the Schedule Screen (see Figure 4-3, Schedule Screen).

---

**4.3.7 Deleting Schedule Details**

Quantum enables you to delete specific activation times and tones within a schedule. You can only delete one time or tone event at a time. To delete a complete schedule, follow the steps below until all entries are deleted for the associated schedule.

1. Follow steps 1 and 2 from section 4.3.6, Modifying Schedule Details.
2. Select the delete option. The time event is deleted.

**NOTE:** Quantum Commander does not prompt you to verify the removal of a time event.

---

**4.4 Defining Administrative Group Assignments**

Administrative groups act as an always answer feature. If the handset or call switch station calling in receives no answer or a busy signal for the day/night admin, then the admin group will ring. In addition, if an emergency-level analog or VoIP call receives no answer, the admin group will ring if the day/night admin does not answer. Quantum enables the assignment of up to thirty-two (32) administrative groups with a maximum of ten (10) administrative stations per group. Administrative stations can be assigned to more than one administrative group. However, you cannot assign administrative phones that are assigned as day or night admin phones to an admin group. Administrative groups work within and between QSPC1 cards and the AdminGroup feature takes priority over call forwarding. To define administrative group assignments, select AdminGroup from the left side of the Quantum Commander screen. The AdminGroup screen displays assigned Arch #s for all administrative groups.

**NOTE:** Only Arch #s assigned to administrative station types, including wall display, show up on the AdminGroup screen. Arch # assignments are completed during station configuration. To assign Arch #s to administrative groups, refer to section 5.2, Defining Station Settings. If station details are not configured prior to creating administrative groups, no Arch #s will be selectable.

**NOTE:** If there is no answer on an emergency call and the emergency link is configured, the administrative group will ring. If the administrative group does not answer, then the call will go to the emergency link station.
Chapter 4  Specifying Facility Information

4.5 Defining Class of Service

Class of Service (CoS) programming allows user-defined parameters for outgoing call privileges and sets various features and options for extensions and outside lines. Quantum allows for the configuration and assignment of up to thirty-two (32) unique CoS definitions. For more details on assigning CoS to station types, see section 5.2, Defining Station Settings. To configure CoS definitions, select CoS Configuration from the left side of the Quantum Commander screen. The CoS Configuration screen displays the call-in level, station call privilege, and unique selectable CoS characteristics.

Fig. 4-9: AdminGroup and Admin Configuration Screen

Arch #  Specifies the unique three-digit architectural number for all in-service stations associated with the administrative group. Valid values range from 000 to 899 for three digit dialing, 0000 to 8999 for four digit dialing, 00000 to 89999 for five digit dialing, and 000000 to 899999 for six digit dialing. All Arch #s associated with administrative station types can be assigned to one or more administrative groups. Administrative station types include Admin MCDS4 Phone only, Admin MCDS4 Phone and speaker or Wall Display.

To create administrative groups, select AdminGroup from the left side of the Quantum Commander screen. Follow the steps below to assign architecture numbers to administrative groups:

1. Double Click on the row of the Admin Group # to display the Admin Configuration Screen (see Fig. 4-9, AdminGroup and Admin Configuration Screens).
2. Select the Arch # from the Available Station(s) column.
3. Select the right arrow key to move the station number to the Selected Station(s) column.
4. Repeat steps 2 and 3 until all desired station numbers are in the Selected Station(s) column.
5. Click Apply to display the station to administrative group assignments. Click Close to quit the assignment.
CoS #  Identifies the user-assigned number (1-32) associated with the defined Class of Service.

Call In Level  For call switch and handset station types, identifies the call as Normal+Emergency, Urgent+Emergency or Emergency only. The system defaults to Normal + Emergency.

   Normal+Emergency: Initiates a normal or emergency-level call. Pressing the call switch once or picking up the handset, triggers a normal-level call to the administrative phone. Pressing the call switch or flash hook four times, triggers an emergency-level call to the administrative phone.

   Urgent+Emergency: Initiates an urgent or emergency-level call. Pressing the call switch or picking up the handset, triggers an urgent-level call to the administrative phone. Pressing the call switch or flash hook four times, triggers an emergency-level call to the administrative phone.

   Emergency Only: Initiates an emergency level call by pressing the call switch one time or lifting the handset.

Station Call Privilege  Specifies the privileges of the CoS for analog or VoIP phones. Valid values include Admin only or All Stations.

Zone Paging  If checked, enables the zone paging for the associated station.

Remote Pickup  If checked, enables remote answering of internal and incoming outside line calls.

Telemedia Control  If checked, enables the assignment of telemedia from the associated phone. Telemedia assignment can be done from administrative and analog phones with the appropriate dial string.

External Call Routing  If checked, enables the station to transfer a call to an outside line.
4.5.1 Creating and Modifying CoS Settings

To configure CoS settings, follow the steps below.

1. Select a CoS number from the drop-down CoS # field. This number is used to identify unique class of service definition (see Figure 4-10, CoS Configuration Screen).

2. Select a Call-in Level from the drop-down menu.

3. Select a Station Call Privilege from the drop-down menu.
4. Use the cursor to select one or more CoS features. When selected, a check mark appears next to the associated feature.

5. Select Apply to save the configured CoS. The saved CoS remains on the screen.

6. To configure additional CoS definitions, repeat steps 1-5 as necessary.

NOTE: To ensure that a valid CoS setting exists for each station type, create a variety of CoS definitions. Some CoS settings do not apply to certain station types, including media, wall display, security, student phone and outside line type. For more detail, see section 5.2, Defining Station Settings.

To modify CoS settings, follow steps 1-5 above, using cursor to select or deselect features as necessary.

4.6 Understanding Neighbor Lists
Quantum enables inter-facility communication to support interaction between multiple facilities within an organization. Using IP Multicast and Quantum’s neighbor list function enables the completion of inter-facility point-to-point calls and paging functions. To create a neighbor list, select Neighbor List from the left side of the Quantum Commander screen. On the Neighbor list Config screen, right click anywhere on the white Facility #/Primary QSPC1 IP box and select New.

![Fig. 4-11: Neighbor List Configuration Screen](image)

**Facility Parameters**
- **Inter-Facility Multicom IP**: Identifies the Multicast address common to all facilities. This feature is used for all-call facilities.
- **Facility #**: Identifies the Quantum facility with a unique user-assigned numeric value. Valid values range from 1 to 99. Facility numbers must be unique within neighbor lists.
- **Primary QSPC1 or IP Address**: Identifies the IP address of the primary card of the alternate Quantum facility.
4.6.1 Creating Neighbor Lists

Quantum enables you to create a maximum of 99 neighbor lists to promote inter-facility communication.

To create a neighbor list, follow the steps below:

1. Select Neighbor List, right click within the Facility # box and select New from the dialog box.
2. Type a facility number 1-99 to identify the unique facility with which you wish to communicate.
3. Type the primary IP address of the alternate facility in the IP address field.
4. Select Apply to accept the networking changes. Select Close to cancel the changes.
5. Repeat steps 1-4 for each facility with which you wish to communicate.
6. For neighbor facilities to call and page to the current facility, steps 1-5 must be repeated from each facility, specifying the IP addresses for each alternate facility. For example, with a two facility network, from facility one, entering a facility number and primary IP address for facility 2 enables facility 1 to send point-to-point calls and pages to facility 2. To enable facility 2 to send calls and pages back to facility 1, a neighbor list must be created at facility 2, specifying a facility number and IP address for facility 1.

4.6.2 Modifying or Deleting Neighbor Lists

To modify or delete neighbor lists, access the neighbor list configuration screen and change or delete the IP address for each facility number as necessary.
Chapter Five

5.0 Configuring the QSPC1

With Quantum, each facility can have multiple QSPC1 Quantum System Processor Cards. For each QSPC1, Quantum enables you to store the information required to program and run the system. The first QSPC1 in the facility should be the primary QSPC1 and configured with a valid IP address. The primary card is responsible for information storage and dissemination within a facility or between facilities when neighbor lists are active. The secondary card acts as backup to the primary card.

5.1 Understanding QSPC1 Card Information

The QSPC1 node configuration screen displays the information entered during initial setup of the unique QSPC1 cards, including node information, SIP stack parameters, software version and station information. For more detailed information, refer to section 2.3, Programming the Processor Cards. To configure the QSPC1 parameters, select QSPC1 from the left side of the Quantum Commander screen. Move between fields using the mouse or Tab keys.

![Node Configuration Screen](image)

**Node**

**QSPC1 #** User-defined numerical (1-64) field used to identify a specific QSPC1. The system displays the number of the QSPC1 selected from the left column of the Quantum Commander screen. QSPC1 # 1 identifies the primary card. Each QSPC1 has a unique number.

**System IP** Identifies the static Internet Protocol (IP) address associated with facility. Also called the Primary Server IP.

**Subnet Mask** Identifies the subnet mask in dotted decimal notation, four numbers from zero (0) to 255 separated by periods, e.g. 255.128.0.0.
**Default Gateway** Specifies the node (router) on the network that serves as an access point to another network when an IP packet's destination address belongs to someplace outside the local subnet.

**Multicast IP** Identifies a group of hosts that have joined a multicast group. All QSPC1 cards within a facility must have the same Multicast IP to ensure correct paging capabilities.

**Type** Identifies the card as a primary, secondary or normal type. A facility can have one primary, one secondary, and one or more normal cards.

**Unit** Identifies the unit as Rack Mount, Wall Mount, or Compact Rack Unit.

**Status** System-populated field displays the system status as online or offline.

---

**SIP Stack Parameters**

**Long Timer** Specifies the maximum amount of time an SIP transaction can remain active, up to 64 seconds. The system defaults to 16 seconds.

**Initial Response Timer 1** Specifies the time at which SIP transaction requests are retransmitted after a non-response in intervals from 500 to 2000 ms. Subsequent requests are retransmitted up to seven times (INVITE transaction). The system defaults to 1000 ms.

**Initial Response Timer 2** Specifies the time at which the non-INVITE transaction requests are retransmitted after a non-response in intervals from 1000 to 4000 ms, or two to four times the value of timer 1. Subsequent requests are retransmitted up to eleven times. The system defaults to 2000 ms.

**Provisional Response Timer** Specifies a time less than the Timer 1 value and from 500 to 1000 ms at which the SIP stack sends a response to the remote end for the received SIP transaction request. The system defaults to 500 ms.

**Max Active Transaction** The maximum number of active transactions per second, between 80 and 200, handled by the SIP Stack. The system defaults to 200.

**Maximum Destination** The maximum number of parallel destinations from 10 to 100 supported by the SIP Stack. The system defaults to 80.

**Short Form Flag** Used for building full or compact header fields in the SIP message. The system defaults to false (full header format).

**Software Version** System-populated field displays the software version on the active and standby sides. The Standby field defaults to not applicable (n/a) and is only populated when software updates have been downloaded. The standby load becomes active after a reset or power cycle.

**Reset** Resets a specific node within the facility, acting as a soft reboot of the system. Any new software on standby will be run after the reset. Only administrative and technician-level user IDs can select Reset.

---

**NOTE:** Additions and/or changes to the system must be saved using the Save option from the File menu. The Quantum Commander prompts you to save configuration information prior to exiting any of the configuration screens. However, it is recommended that when entering information, it is saved on a regular basis to avoid losing data.
5.1.1 Configuring Additional QSPC1 Cards

To configure additional QSPC1 systems within a facility, select the File option at the top of the Quantum Commander screen. Selecting the New System option from the File drop-down menu creates a new QSPC1# on the left side of the Quantum screen. To configure the new QSPC1 system, follow the steps outlined in section 5.1, Understanding QSPC1 Card Information.

5.1.2 Deleting QSPC1 Information

To delete the configuration of one or more QSPC1 systems, follow the steps below.

1. Using the mouse, highlight the QSPC1# on the left side of the Quantum Commander screen.
2. Select the File option at the top of the Quantum Commander Screen.
3. Select Delete from File option drop-down menu.
4. At the system prompt, select Yes to delete the QSPC1 or No to cancel the delete.

NOTE: The default or primary QSPC1 information can not be deleted using the Delete option. To modify the configuration of the primary QSPC1, see section 2.3, Programming the Processor Cards.

5.2 Defining Station Settings

The Station screen enables you to create, review or modify up to 265 stations depending on unit type for each QSPC1 within a facility. The numbered stations represent the associated station ports on the Quantum system.

<table>
<thead>
<tr>
<th>STYLE</th>
<th>ANALOG STATIONS</th>
<th>OUTSIDE LINES</th>
<th>VoIP STATIONS</th>
</tr>
</thead>
<tbody>
<tr>
<td>RACK MOUNT</td>
<td>SINGLE</td>
<td>1-120</td>
<td>241-255</td>
</tr>
<tr>
<td></td>
<td>DOUBLE</td>
<td>1-240</td>
<td>241-255</td>
</tr>
<tr>
<td>WALL MOUNT</td>
<td>NO TEL CARD</td>
<td>1-120</td>
<td>N/A</td>
</tr>
<tr>
<td></td>
<td>WITH TEL CARD</td>
<td>1-96</td>
<td>97-104</td>
</tr>
<tr>
<td>QCR</td>
<td>24</td>
<td>1-24</td>
<td>97-104</td>
</tr>
<tr>
<td></td>
<td>48</td>
<td>1-48</td>
<td>97-104</td>
</tr>
</tbody>
</table>

Table 5-1: Maximum Stations by Unit Type
5.2.1 Configuring Station Settings

To access the Station Configuration screen, select a QSPC1 (#) from the left side of the Quantum Commander screen and select Station from below the QSPC1 (#). A listing of all configured and available to be configured stations appears. To configure a station, click anywhere on the row for that station to access the Station # screen.

![Station Configuration Screens](image)

Station Type

Specifies one of 20 station type combinations and identifies the type of end-of-line device. The station type selected affects which remaining station information is required and available for configuration.

For Station Type:

- **Speaker Only**
  - Ceiling or wall-mounted speaker capabilities.

- **Non-Dial Handset Only**
  - A telephone style handset without dialing capabilities. The handset can initiate normal, urgent or emergency-level calls by lifting the handset, depending on call-in levels assigned during CoS configuration (see section 4.5, Defining Class of Service). The handset rings the administrator phone.

- **Non-Dial Handset & Speaker**
  - Both speaker and non-dial handset capabilities as defined above. If the handset is placed back on-hook, the call goes to the speaker when the administrator answers.

- **Call Switch & Speaker**
  - Call Switch and Speaker capabilities and a call switch that initiates a normal, urgent or emergency call based on the number of times the switch is pressed. After the call switch is pressed, it connects to the administrator phone.

- **Call Assurance Call Switch & Speaker**
  - Call Switch and Speaker capabilities and a call switch that includes an LED to indicate when a call to the administrator phone has been initiated. When the Administrator terminates the call, the LED light will turn off.

- **Non-Dial Handset, Call Switch, & Speaker**
  - Non-dial handset, call switch and speaker capabilities as defined above.
### Analog Phone Only
- Standard analog phone, similar to those used in most homes and small offices. The analog phone can initiate emergency calls to the administrator phone if the flash hook is pressed four times.

### Analog Phone & Speaker
- Standard analog phone and speaker capabilities as defined above.

### Analog Phone, Call Switch, & Speaker
- Standard analog phone, call switch and speaker capabilities as defined above.

### Admin Display Phone Only
- A 4x16 character administrative display telephone. The display panel shows the time of day and day of week, the current time signaling schedule, and the station numbers and call-in priority of stations that have called a particular administrative station.

### Admin Display Phone & Speaker
- A 4x16 character administrative display telephone (as described above) and speaker capabilities provide voice annunciation of room numbers from non-dial stations and all emergency-level calls. Voice annunciation is not defeatable.

### Wall Display
- Wall-mounted display unit that indicates time of day, active time signaling schedule, the station numbers, call-in priority of stations, and emergencies, including 911 calls.

### Outside Line
- Telephone that connects directly to an outside line. For each unit type, specific ports are reserved for outside line connections. For wall units, stations 97–104; for rack mounts, stations 241–255; and for compact units, stations 97–104. If these stations are not defined as outside line connections, then the station is disabled. Note: Station numbers are not contiguous (e.g., on a compact unit, stations 48–97 are empty).

### DISA Line
- Telephone direct inward system access (DISA) capabilities enabling feature control from remote telephones. DISA lines follow the same port assignments as outside lines but with direct inward access.

### Telemedia Controller
- Capability to control televisions, VCRs and DVDs from any dial phone or PTMRC (telemedia remote control).

### Student Phone
- Outbound-call only student phone allowed to make 7 or 10-digit, local and 911 calls. Call duration is limited to five minutes or less, with a momentary dial tone at 4:30, 4:40, and 4:50. At five minutes, calls are disconnected. A student phone can not receive any incoming calls and the station can not redial the same number for up to 30 minutes. If a redial is attempted in less than 30 minutes, a busy signal is sent to the phone.

### Security
- Capability of being programmed for normally opened or closed contacts for use with door strike, motion detectors, cameras or any low-voltage, dry contact creating device. A security station configuration changes the functionality of the port to monitor a normally opened or normally closed contact port.
911 Line  Capability to initiate a 911 call from a dial phone. When a classroom has dialed 911, the associated administrative phone displays the station number and notifies the main office, enabling administrators to direct emergency personnel to the correct physical location in the building. All admin phones ring with a special 911 or emergency level ring. Wall displays flash “911 alert” and display the arch # of the phone that dialed the alert. A 911 line is an outside line that connects the station to a 911 call center. The outside line port assignments defined in Outside Line above apply to the 911 line. Multiple 911 lines can exist per unit, but once a station is defined as 911, it can ONLY be used as 911.

VoIP Phone Only  Bogen approved SIP or Voice over IP capable telephone connected directly to the network with a unique static IP address. Last ten ports for each unit type (wall, rack or compact unit) are VoIP only ports.

VoIP Phone & Speaker  VoIP telephone and speaker capabilities as defined above.

Arch#  Specifies the unique three-digit architectural number for all in-service stations. Valid values range from 000 to 899 for three digit dialing, 0000 to 8999 for four digit dialing, 00000 to 89999 for five digit dialing, and 000000 to 899999 for six digit dialing. A system-populated value of 999 indicates that the station is inactive.

Outside Access  Specifies the type of restrictions, if any, placed on outside line access.

Day Admin  Identifies the administrative station that will cover the station during daytime hours.

Night Admin  Identifies the night administrative station associated with the station.

Day CoS  Identifies the day CoS (1-32).

Night CoS  Identifies the night CoS (1-32).

Authorization Code  Allows the user to enable additional features on a phone when the walking CoS feature is enabled. The four-digit code activates features from the associated phone to the phone being used.

Admin Group  Identifies the Admin Group (1-32) associated with the station. Only previously defined admin groups are valid. Do not assign an undefined admin group to the station.

IP Address  Specifies the IP address of the VoIP phone.

User Text  This field allows for a custom entry description to aid in identifying each station or some other key attribute. A maximum of 10 characters may be used.

Zones

Available Zones  Lists the selectable zones to associate with the station based on station and zone types.

Selected Zones  Lists the zones assigned to the station.

Apply  Accepts changes to station configuration.

Close  Cancels station configuration.
5.2.2 Excluding Paging Capabilities

To specify whether to include or exclude paging for each station within a QSPC1, right click on the associated station row. Select to include or exclude paging from the pop-up menu. If Exclude Paging is selected, the station information text changes to red. If Include Paging is selected, the text remains black. Repeat the paging selection for each configured station. Quantum defaults to include paging. This option applies to Page and Time Zone types only. Pages sent as All-Call or Emergency-Level All-Call will still be sent and heard at the station, regardless of whether that station is set to Include or Exclude Paging.

5.2.3 Copying Station Settings

Quantum Commander enables you to copy a station configuration to one or more additional station numbers. To copy a configured station setting, enter the Arch # of the station to copy on the Source field. On the Destination field, specify the station or stations to which to copy the source station information. You can specify multiple station numbers at once. For example, to copy the configuration of station one (1) to stations 3, 4, 5, and 8, type “3-5, 8” on the Destination field.

5.2.4 Deleting Station Settings

To delete or clear station information from the screen, click anywhere on the row associated with the station to delete. Select n/c (not configured) to clear previously configured station information.
Chapter Six

6.0 Using System Tools

The Quantum Commander provides you with a variety of system tools to test and restore the system. All tools options require an administrative or technical ID.

![Tools Menu Screen](Fig. 6-1: Tools Menu Screen)

The Tools option fields are:

- **Download**: Downloads the Quantum application software to the QSPC1 processor cards. The download feature is also used to download announcement .raw files to the primary processor card.

- **Diagnostics**: Initiates systems functions and cards tests. Systems functions include Clock test, Flash Memory and RAM test. Cards tests enable the selection and testing of specific cards within one or more of the associated system racks.

- **Backup**: Saves all current system configuration files to a specified folder.

- **Restore**: Sets the system back to values saved during a previous backup.

### 6.1 Downloading Information to the Quantum Commander

Quantum Commander enables you to download software updates, or previously recorded announcements and tones to a specific QSPC1 within a facility. Prior to selecting the download option, you must first select the QSPC1 (#) from the left side of the Commander screen. Then, to download software or announcement updates, select the Download option from the Tools menu.

NOTE: The download options remain grayed out unless you first select a QSPC1 (#) from the left side of the Commander screen.
6.1.1 Downloading Software

Quantum Commander enables you to download Quantum application software to the QSPC1. Application software must be downloaded separately to each QSPC1 card in the facility. The latest Quantum software is available at: www.bogen-es.com/quantum/quantumLogin/quantumDealers. First download the application from Bogen’s FTP site and save it to the computer that will be used to upgrade the QSPC1 cards. Only users with administrative and technician IDs can initiate the software download option.

NOTE: Each card in the facility must be downloaded separately. Highlight by double-clicking each QSPC1 on the left side of the Quantum Commander screen and repeat the download process.

- **Browse** Click the browse button and navigate to the location of the application software that was previously retrieved from the Bogen Communications website. Application software has the extension .tar. Double clicking on the desired application file will select the file and close the Browse window.

- **Download** Click to initiate the download of the application software to the selected QSPC1 card. It may take a few minutes for the download to finish. You will see an FTP success message when the download is complete.

- **Close** Closes the Software Download screen. If the Close option is selected prior to selecting the Download option, the download is cancelled and the Selected Files field defaults to blank. After all nodes have been downloaded, Power-OFF all of the nodes. Then Power ON again.

**IMPORTANT**: After all QSPC1 cards in the facility have been downloaded, all cards must be power cycled (turn power off wait 10 seconds and turn power on). Be sure all cards have been updated before power cycling the hardware.

6.1.2 Downloading Announcement Files

Quantum Commander enables the download of audio files from a PC to the QSPC1. To initiate an audio file or announcement download, select the Announcements option from the Download menu to display the Download Files screen. Only administrative and technical IDs can select the Announcements download option.

- **File type is**: .raw
- **Sample type is**: 8KHz 8 bit G.711 A-law

NOTE: The files must be renamed to their corresponding message number before downloading to the processor. For example message 1.raw needs to be renamed to simply the number 1. Up to 9 messages, not to exceed 5 minutes total, can be downloaded.
6.1.3 Downloading Tones

User-customized Emergency and Manual/Time Tones may be downloaded using Quantum Commander to replace the factory default tones in Quantum.

File type is: .raw
Sample type is: 8KHz 8 bit G.711 A-law

The files must be renamed with the extension changed from.raw to .G711, according to the chart (see Table 6.4). Each tone must not exceed 5 seconds in duration. To facilitate the download, it is recommended the files be placed in the My Documents folder in Windows.

NOTE: Manual/Time Tone 8 (eight) cannot be replaced with a user-customized tone.

To initiate a tone download:
1. Access Quantum Commander using either a technician or admin ID and password.
2. Double click on the QSPC-01 folder on the left side of the screen.
3. Select the Download and Tone options from the Tools Dropdown menu.
4. Click on the browse button of the Download Tones dialog box.
5. Click on the file(s) to be downloaded. Select Open, and then Download.

When the file has been successfully downloaded, an FTP Success message will be displayed. Repeat this process for each node of the facility.

<table>
<thead>
<tr>
<th>TONE NAME</th>
<th>FILE NAME</th>
</tr>
</thead>
<tbody>
<tr>
<td>Emergency Tone 1</td>
<td>tone_1.G711</td>
</tr>
<tr>
<td>Emergency Tone 2</td>
<td>tone_2.G711</td>
</tr>
<tr>
<td>Emergency Tone 3</td>
<td>tone_3.G711</td>
</tr>
<tr>
<td>Emergency Tone 4</td>
<td>tone_4.G711</td>
</tr>
<tr>
<td>Manual/Time Tone 1</td>
<td>tone_5.G711</td>
</tr>
<tr>
<td>Manual/Time Tone 2</td>
<td>tone_6.G711</td>
</tr>
<tr>
<td>Manual/Time Tone 3</td>
<td>tone_7.G711</td>
</tr>
<tr>
<td>Manual/Time Tone 4</td>
<td>tone_8.G711</td>
</tr>
<tr>
<td>Manual/Time Tone 5</td>
<td>tone_9.G711</td>
</tr>
<tr>
<td>Manual/Time Tone 6</td>
<td>tone_10.G711</td>
</tr>
<tr>
<td>Manual/Time Tone 7</td>
<td>tone_11.G711</td>
</tr>
</tbody>
</table>

Table 6.4: Naming Downloaded Tones
6.2 Running Diagnostic Tests

Quantum Commander diagnostic tests are used to validate system functions and cards within a QSPC1. To run diagnostics on boards installed in the secondary or normal modes, Commander must be accessed from those nodes. Browse to the IP Address of the secondary node to test boards in the secondary nodes. Three types of system cards are checked, including Analog, Station and Telephone (TELCO) cards. To access the Diagnostics screen, select Diagnostics from the Tools option drop-down menu.

Show Post Results
Display results of diagnostic checks run on processor boards during boot-up.

Analog Card Test
The analog card test sends tones over the speaker of the first defined station. If the tone is not heard, the analog card is defective and must be replaced.

Station Card Test
The station card test verifies the off-hook status of the telephones connected to the stations. If a station is off-hook, the off-hook location is displayed on the screen. The audio busses are tested by sending a tone over each bus. If any of the tests fail, the card is defective and must be replaced.

Telephone Card Test
The telephone card (TELCO) test verifies the ring for each line on the telephone card. If the ring is not detected, an error message is displayed. The DTMF receivers and audio busses are also checked. The audio busses are tested by sending a tone over each bus. If any of the card tests fail, that card is defective and must be replaced.

If any of the card tests fail, that card is defective and must be replaced.

NOTE: To test any or all of the cards, an analog card must reside in the first slot of the Quantum unit.

NOTE: Diagnostic tests run on one QSPC1 at a time.
6.3 Performing a System Backup

You should initiate regular system backups following any changes to the system programming, including card, station and zone configurations. Execute an initial system backup following the programming of all primary, secondary and normal processor cards as outlined in section 2.3, Programming the Processor Cards. To perform regular backups from within the Quantum Commander browser, follow the steps below.

1. Select any of the QSPC1 cards from the left side of the Quantum Commander screen.
2. Select the Tools option from the top of the screen.
3. Select the Backup option from the Tools drop-down menu.

Quantum saves the configuration information for the entire system and creates three separate files (config.db, maintenance.db, system1.db). Facility-wide there is one config.db and one maintenance.db. There is SystemX.db for each node:

\[(node1 = system1.db, node2 = system2.db, node3 = system3.db)\]

**NOTE:** If both the primary and secondary card experience technical problems and can not be used to restore the system, use the maintenance or administrative ID to change one of the existing normal cards to the primary card. The new primary card can then be used to backup the data without the need for a direct Ethernet connection. The restoration is done entirely through the network.

6.4 Restoring the System

Quantum Commander also enables administrators to restore the facility to a previous date and time using the database files created from a previous system backup. To perform a system restore, follow the steps below.

1. Double click on any of the QSPC1 entries on the left of the Quantum Commander screen.
2. Select the Tools option from the top of the Quantum Commander screen.
3. Select the Restore option from the Tools drop-down menu.
4. From the Open screen, select the name of the folder in which the system backup files are stored. To locate the folder, use the down arrow next to the Look In: field, Up One Level icon , Desktop icon , List icon, or Details icon .
5. Select the Open option from the bottom of the screen.

Quantum restores the system using the backup files identified in section 6.3, Performing a System Backup and notifies you when the restore is complete. The system is restored to its status as of the date and time of the most recent backup.

**NOTE:** To enable the Restore option, a QSPC1 must first be selected via a double click from the left of the screen. If a QSPC1 number is not selected via a double click, the Restore option remains grayed out and is not selectable from the Tools menu.

**NOTE:** The system must be reset to finalize the restore. To reset the system, click the RESET button on the QSPC1-1 screen. This will then reset the entire facility.
Quantum Commander provides administrators with real-time control over tones, announcements/emergency messages and security zones. To configure, modify or review these settings, access the Admin option at the top of the Quantum Commander screen.

The Admin Menu fields are:

- **Tones**: Indicates which alarm tone (1-4), manual tone (1-9) or emergency message is heard when a zone is activated.

- **Audio Distribution**: Specifies the audio program distributed to station(s) or zone(s) within a facility.

- **Input Relays**: Activates the specified externally-triggered time tone associated with time zone (1-6). Input relays can also specify which emergency message to play as an all-call page when the corresponding input is closed. If no message is specified, the external tone is distributed to the corresponding time zone as long as the contact is closed.

- **External Relays**: Specifies the activation time and duration for hourly contact closures and twice-a-day relays, and activation and deactivation times for each of four external relays. Also identifies which day(s) twice-a-day relays are active. The color of the External Relay buttons indicates relay activity status: red is open, green is closed. Clicking on the External Relay button changes the state of the relay.

- **Media**: Lists media station assignments and specifies the times at which the TV On or Off code is sent to all remote control units (TMRC).

- **Arm/Disarm Security Zones**: Enables the arming or disarming of previously defined security zones.

- **Outside Line Status**: The on-hook or off-hook status of each outside line is indicated.
7.1 Selecting Tones and Announcements

Quantum enables the real-time activation of manual tones, alarm tones and emergency messages to a primary QSPC1 for distribution to the entire facility. The activation of alarm tones or emergency messages using the admin function overrides any active paging or current tones.

To initiate tones or messages, follow the steps below.

1. Using the mouse, highlight the QSPC1 from the left side of the screen.
2. From the top of any Quantum Commander screen, select the Tones option from the Admin drop-down menu (see Figure 7-1, Admin Menu).
3. On the Tones and Announcement screen (see Figure 7-2, Tones and Announcement Screen), select Alarm Tone, Manual Tone or Emergency Messages. You can select only one of the three options at a time.
   - To initiate an Alarm Tone, select Alarm Tone and the number associated with one of the four available tones.
   - To initiate a Manual Tone, select Manual Tone and the number associated with one of the nine available tones.
   - To initiate an Emergency Message, select Emergency Message. Move to the drop-down arrow of the files field and select one of the pre-recorded emergency message file names.
4. Select Start to initiate the tone or announcement. Alarm tones and emergency messages commence immediately, overriding any currently playing tones or announcements. Manual tones begin following any currently playing tones or announcements.
5. To end the tone or message prior to its completion, select the Stop option.
7.2 Distributing Audio

Quantum Commander provides the ability to switch an audio source, such as a microphone or CD, into the system, enabling you to distribute audio to select stations or zones within a facility. By selecting the Audio Distribution option from the Admin drop-down menu, you specify which QSPC1 acts as the program source and which of the three program channels is active. Quantum also enables the specific selection of stations and/or zones for distribution.

To initiate audio program distribution, follow the steps below.

1. Select the Audio Distribution option from the Admin drop-down menu.
2. Select the down arrow to specify the QSPC1 from the drop-down menu.
3. Using the mouse, select a program to distribute.
4. Using the mouse, select the Station(s), All Stations or Zone(s) option.

**Selecting a Station(s)**
When you select the Station(s) option, you must specify to which station or stations to distribute the audio program. Using the mouse, highlight the desired station from the drop-down menu and select the right arrows to move the selection to the selected stations column. Repeat as necessary. To remove a station from the list, highlight the selection in the selected stations list and select the left arrows. To select all available stations, select the All Stations option.

**Selecting a Zone(s)**
When you select the Zone(s) option, you must specify to which zone or zones to distribute the audio program. Using the mouse, highlight the desired zone(s) from the available zones drop-down menu and select the right arrows to move the selection to the selected zones column. To remove a zone from the list, highlight the zone in the selected zones field and select the left arrows.

5. Select Distribute to initiate the audio program.

7.3 Configuring Input Relay Closures

Quantum enables you to configure up to six input relay closures for a facility. Input relay closures activate externally triggered time tones associated with time zones one through six. Input relays can also trigger an emergency message to play as an all-call page when the corresponding input is closed. If an emergency message is not specified, the external time tone is distributed to the corresponding time zone as long as the contact is closed. Input relays open and close in parallel within a facility. To configure one or more input relays, select the Input Relays option from the Admin drop-down menu.
To override tones and assign emergency messages to the associated times zones, follow the steps below.

1. Select the Input Relays option from the Admin drop-down menu.

2. Select the down arrow to specify the External Time Tone from the drop-down menu.

3. On the Emergency Messages field, specify a message and number for each time zone as needed.

4. Select Save to save the assignments or Close to cancel and leave the Input Relays screen.

For more information on Input Relays, refer to the Quantum Multicom IP Installation Instructions. For more information on emergency messages, see section 6.1.2, Downloading Announcement Files.

**7.4 Configuring External Relays**

Quantum enables the configuration of up to four external relays. To define one or more external relays, select the External Relays option from the Admin drop-down menu. If the Relay number is highlighted in red, the relay is off. A Relay number in green indicates that the relay is turned on. External relays act in parallel within a facility.

**Hourly Contact Closure**

**Minutes To Trigger** Indicates the number of minutes after the hour at which the Hourly Contact Closure or Hourly Relay (Pin 5 on P5) is activated. For example, a value of 55 triggers Pin 5 to activate every hour at 55 minutes past the hour. Valid values range from 0 to 59.

**Distribution In Seconds** Specifies the amount of time the Hourly Contact Closure or Hourly Relay is active. Pin 5 can be activated for 1 to 59 seconds.
**External Relays**

<table>
<thead>
<tr>
<th>On Time</th>
<th>Indicates the activation time for each of the four external relays. Time is entered in 24-hour format. Relays 1 through 4 correspond to pins 9-6 on P5.</th>
</tr>
</thead>
<tbody>
<tr>
<td>NOTE:</td>
<td>On Time must be less than or equal to Off Time.</td>
</tr>
<tr>
<td>Off Time</td>
<td>Indicates the deactivation time for each of the four external relays. Time is entered in 24-hour format. Relays 1 through 4 correspond to pins 9-6 on P5.</td>
</tr>
<tr>
<td>NOTE:</td>
<td>Off Time must be greater than or equal to On Time.</td>
</tr>
<tr>
<td>Secs</td>
<td>Specifies the total number of seconds after Off Time at which each of the four external relays deactivates, enabling Off Time to be programmed to the second. Valid time ranges are from 0 to 59 seconds.</td>
</tr>
<tr>
<td>NOTE:</td>
<td>If On Time equals Off Time, seconds can not be zero (0).</td>
</tr>
</tbody>
</table>

**Twice-A-Day Relays**

Two times a day two different switches may be triggered for a set period of time. These switches may be closed primarily for secondary clock control and correction.

**Closure 1 & 2**

Twice-a-Day Relay Feature. The Twice-a-Day Relay (P5 pin 4) is activated at the times specified for the associated duration.

<table>
<thead>
<tr>
<th>On Time</th>
<th>Indicates the activation time for the associated contact closure. Valid times range from 00:00 to 23:59. Quantum prevents invalid time entries.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Duration</td>
<td>Indicates the number of seconds associated with the contact closure. Valid durations range from 0 to 59 seconds. Quantum prevents invalid duration values.</td>
</tr>
<tr>
<td>Schedule</td>
<td>Designates the specific days associated with the Twice-A-Day Relay. A check-mark indicates that the relay is active on the associated day.</td>
</tr>
</tbody>
</table>

For more information on External Relays, refer to the Quantum Multicom IP Installation Instructions.

---

**7.5 Configuring Media Assignments**

Quantum Commander enables an administrator to configure media assignments and television schedules for all stations defined as Telemedia Controller. Station type is defined during QSPC1 station configuration (refer to section 5.2, Defining Station Settings). You must configure media assignment for each QSPC1 within a facility. To configure media assignments, follow the steps below.

1. Access the Media option from the Admin drop-down menu.
2. Assign station numbers to the media station by selecting station numbers from the Assigned Stations drop-down menu.
3. Type the On and Off Time in military format.
4. Select the day or days of the week for which the telemedia controller assignment is active.
5. Select Save to send the media assignment information to the primary QSPC1 for distribution or Close to cancel.
Media Assignment

Media Stations Lists the arch # associated with stations previously defined as telemedia controllers. If no stations were configured as telemedia, the field defaults to zero (0).

Assigned Stations Provides a drop-down list of all station numbers associated with the telemedia controllers.

TV

On Time Specifies the time in military format at which the TV On code is sent to all telemedia control units connected to enhanced staff and administrative level stations.

Off Time Specifies the time in military format at which the TV Off code is sent to all telemedia control units connected to enhanced staff and administrative level stations.

Schedule Identifies the days associated with the TV On and Off times defined above. A checkmark indicates that the on and off time applies to the associated day.

7.6 Arming/Disarming Security Zones

The Arm / Disarm Security Zones administrative option enables the (de)activation of previously defined security zones throughout a facility (see section 4.2, Configuring Zone Information).

To arm/disarm security zones, follow the steps below.

1. Select the Arm / Disarm Security Zones option from the Admin drop-down menu.
2. Using the mouse, select a security zone from the Disarmed Zones column and select Arm to move the zone into the Armed Zones column. To disarm a zone, select the zone from the Armed Zones column and select Disarm.
3. Select Close to complete and save the security zone changes.
7.7 Outside Line Status

The status of every outside line in a facility can be seen by using this feature. Each row represents the status of the outside lines associated with a particular QSPC1 card in the facility. Up to 2 MCTC cards can be installed into a Quantum node (installing 2 MCTC cards requires a double card cage node) for a maximum of 15 outside lines per Quantum node. The Refresh button must be pushed to see the most current status of all the outside telephone lines in the facility. The display indicates the line number relative to the particular QSPC1 card and not the actual architectural number assigned to that outside line.

Fig. 7-7: Outside Line Status
Quantum Commander provides administrators control over all levels of login IDs, including the adding and deleting of the IDs and their associated passwords.

Selecting the List option from the Account drop-down menu displays the Account Details screen. The Account Details screen displays a complete list of all administrative, technician and general user IDs configured within Quantum Commander. The screen also provides the ability to add and delete login IDs, and modify passwords.

NOTE: For more information on user IDs and their associated privileges, see section 3.0, Accessing Quantum Commander.

NOTE: The default administrator ID and password can not be modified from within Quantum Commander.

### 8.1 Adding Login IDs

To add technicians, administrators or general users to the Quantum system, select the Add button from the bottom of the Account Details screen or select the Add User option from the Account drop-down menu. The Add User screen is displayed (see Figure 8-1, Account Details and Add User Screens).

**The Add User screen fields are:**

- **Login Name** Specifying the eight-character login ID.
- **Group** Identifying the user type as Admin, Technician or (general) User.
- **Password** Specifying the eight-character password associated with the login ID.
- **Add** Adds the Login Name and associated ID characteristics to the system.
8.2 Deleting Login IDs

Quantum Commander enables quick and easy deletion of technician, administrator or general user IDs. To remove one or more existing IDs from the Quantum System, select the Delete button from the bottom of the Account Details screen. Quantum deletes the ID from the system immediately.

![Image](image_url)

**NOTE:** Deletion is immediate upon selecting the Delete option. If you delete a login ID accidentally, refer to section 8.1, Adding Login IDs.

**NOTE:** The default administrator ID can not be deleted from the system.

8.3 Changing User Passwords

All users can modify their existing password by selecting the Change Password option on the Account drop-down menu. To modify your password, follow the steps below.

1. On the Change Password screen, type your current password on the Old Password field.
2. Type a new password on the New Password field. Passwords must be between 1 and 8 characters in length.
3. Re-type the new password on the Re-type Password field.
4. Select Change to update the password. The new password is effective immediately.

Quantum Commander allows administrators to modify all passwords other than the default Admin password by selecting the Change Password option on the Account Details screen (see Figure 8-1, Account Details and Add User Screen). To modify one or more login IDs, follow the steps below.

5. Select the List option on the Account drop-down menu to display the Account Details screen.
6. On the Account Details screen, select the login name associated with the password to modify to highlight the entire login name row.
7. Select Change Password from the bottom of the Account Details screen to display the Change Password screen.
8. To complete the password change, follow steps 1-4 above.
9. Repeat steps 5-8 as necessary for additional login names.
Chapter Nine

9.0 Creating a System Report

The Quantum Commander enables you to print a file or hard copy report of each QSPC1, including passwords. The detailed reports can be sorted by station number, architectural number, level, day or night administrator stations. To create a report, select the desired QSPC1 on the Quantum screen. To access the Report screen, select the Report option from the File menu (see Figure 9-1, Report Screen).

To create a system report, follow the steps below.

1. Type a name for the report on the File field, or click on the Browse button to select an existing file name from the resident computer.

   NOTE: If an existing file is selected, the file will be overwritten when the Save Report option is selected.

2. From the Report screen, select the desired sort criteria.

3. Select the Save Report option to create a report file, OR
   Select the Print Report option to create a physical printout.

4. To create additional reports, repeat steps 1-4.

5. Select Close to exit the screen.

   NOTE: The system printout is not a secure document. All information entered into the Quantum Commander, including passwords, appears on the printed copy.